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For questions or comments, please contact ISSI 
Innovative Scientific Solutions, Incorporated 
7610 McEwen Road 
Dayton, OH 45459 
Ph.: (937) 630-3012 
Fax: (937) 630-3015 
www.innssi.com/FootSTEPS 
Email: issi-sales@innssi.com 
  

3 
 

http://www.innssi.com/FootSTEPS
mailto:issi-sales@innssi.com


  Innovative Scientific Solutions, Inc. 
 

Introduction 
ISSI’s FootSTEPS technology provides the first-ever capability to measure normal and 

shear force distributions under the entire foot during gait testing.  The information is 

captured dynamically with the frequency determined by the camera data capture rate. 

The FootSTEPS system integrates ISSI’s patented Surface Stress Sensitive Film (S3F) 

technology with a force plate system produced by companies such as Bertec, AMTI, and 

Kistler. 

The resultant FootSTEPS system provides the “best of both worlds” … distributed 

normal and shear force measurements, not available in any other system, combined with 

ground reaction force measurements that gait researchers know and trust. 

System Drawing 

 CAUTION: As shown in the system drawing there are removable ports and and panels on the 

system optical box.  Removal of any of these items can result in a loss of optical alignment 

and calibration of the system.  Port or optical window removal should only be done under 

instruction from ISSI. 
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Principle of Operation 
A single high-resolution camera images an S3F layer polymerized on a 1-inch thick 

tempered glass window located in the upper surface of the FootSteps system box.  The mirror 

arrangement allows for a longer optical path and the use of lenses with low optical distortion. 

LED arrays, located below and to either side of the window, illuminate the film for camera 

operation.  The optical box also contains power supplies for camera and LEDs, as well as a 

pulse generator that synchronizes LED pulses and camera framing.  Cooling fans ensure a 

stable operational temperature. 

The force plate, mounted underneath the optical box, simultaneously measures three 

forces and three moments about the x, y, and z axes.  Synchronized data collection is initiated 

by a trigger pulse from the force plate on initial foot contact.  The data colletion period ends 

when no contact is detected, or when the maximum number of camera images is collected.  
This maximum is sufficient to ensure full data capture regardless of the direction of travel 

across the FootSTEPS system.   

The non-compressible S3F layer contains a probe that enables changes in film 
thickness, produced primarily by normal foot contact forces, to be visualized as changes in 

illumination level.  The mathematical ratio of loaded and unloaded images quantifies the 

vertical displacement of the film.  A series of markers are applied to the film below the 

opaque upper layer.  These markers are displaced laterally during foot contact, primarily by 

tangential forces.  Cross-correlation analysis quantifies the displacements produced by shear 

forces.  3-D displacement maps provide rapid visualization of the pressure and shear patterns 

produced by plantar contact.  Reconstruction of the pressure and shear force values is 

provided by offline analysis using a finite element model of the S3F with the measured 

displacements as inputs. 
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Description & Specifications 
Power 110-120 VAC 
Interface Dedicated USB 3.0 for camera connection  

(HighPoint Rocket U 1144C is recommended. 
Call ISSI for guidance if you cannot obtain 
this specific card). 
USB 2.0 for others. 

Linear Pressure Range 15 to 700 kPa. Unsaturated response to greater 
than 2000 kPa.   

Linear Shear Range 3 to + 100 kPa. Not saturation point; limit 
without test form slippage. 

Accuracy + 5% of full scale for both pressure and shear. 
Crosstalk  Less than 3% between pressure and shear. 
Data Capture Rate 50 frames per second. 
Spatial Resolution for Reconstructed Forces 2 mm. 
Active Measurement Area 32 by 43 cm (12.6 by 17 inches). 
S3F and Force Plate Data Streams Synchronized via force plate amplifier signal. 
Software • Acquires images and force plate data. 

• Computes normal and tangential film 
displacements. 

• Provides immediate post-run display of the 
pressure and shear displacements to insure 
that good data were collected. 

• Reconstructs the pressure and shear forces 
using freeFEM++ and offline batch processing. 

• Displays pressure and shear maps, plots 
pressure and shear values temporally and 
spatially, and conducts mask-based analysis. 

Weight 305 lbs, not including the force plate. 
Size 91.4 cm (L) by 53.3 cm (W) by 54.9 (H). (36 by 21 

by 21.625 inches), not including the force plate. 
Warranty 24 months – see License Agreement and Limited 

Warranty. 
6 months – S3F layer, excluding damage caused 
by customer mishandling. 

Product Maintenance 24 months – see License Agreement and Limited 
Warranty. 
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Software Installation 

 Instructions for Loading the FootSTEPS Data Acquisition Software 1.

The FootSTEPS acquisition software is 64-bit and compiled for 64-bit Windows 

operating systems Vista, 7 and 8.1. 

Run Setup_FootSTEPS_acquisition_interface.exe. The setup page will open and 

prompt the user to continue with the installation. 
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The setup will next open and display the license agreement for the software. 

  

 

Confirm the destination where the software will be stored and proceed with the installation. 
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Ensure that all USB-devices (Camera, ISSI Pulse Generator (PSG), and Force Plate) have 

drivers by checking the Windows Device Manager. 
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 Instructions for Loading the FootSTEPS Data Analysis Software 2.

The software for batch analysis of step data from the FootSTEPS system consists of 

four separate programs. These programs include: FreeFEM++, FootScripts, 

Foot_Analysis_Scheduler, and FootPlots. The FreeFEM++ program is freeware available for 

download from the internet, while the other programs are C-based programs available only 

from ISSI.  

a. Installing FreeFEM++ v3.46: Please navigate to the following site: 

http://www.freefem.org/ff++/ and select from the download precompile version 

section the Windows 32bit: FreeFEM++-3.46-win32.exe package. Download and 

install this package. 
b. From the installation package supplied by ISSI go to the FootScripts folder and 

locate cvidistkit.FootScripts_1. Open this folder and the Volume folder located 

inside and find the setup program. Launch the setup program and the following 

Destination Directory dialog will appear:  

 

 

 

10 
 

http://www.freefem.org/ff++/


  Innovative Scientific Solutions, Inc. 
 

Change the target directory from C:\Program Files (x86)\FootScripts\ to 

C:\FootScripts\ 

  
 

and hit the next button. The review dialog will appear asking you to confirm the 

installation, hit next to complete the installation.  

 
 

The FootScripts program will now be located in the startup menu and directly in 
the c:\FootScripts\folder.  Once the setup is complete, copy all remaining files 

from the ISSI FootScripts folder into the c:\FootScripts\ folder. It is not necessary to 

overwrite the just installed files. The FootScripts program should now be fully 

installed and ready for use. 

c. From the installation package supplied by ISSI go to the FootPlots folder and 

locate cvidistkit.FootPlots. Open this folder and the Volume folder located inside 

and find/run the setup program. Follow the same steps as discussed in the 
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FootScripts installation, namely, change the target file to the c:\FootPlots\ folder, 

hit the next button to start the installation and when the installation is complete 

copy all folders from the ISSI supplied FootPlots folder to the newly installed 

c:\FootPlots\ folder. 
d. From the installation package supplied by ISSI go to the foot_analysis_scheduler 

folder and locate the cvidistkit.foot_analysis_scheduler_1. Open this folder and the 

Volume folder located inside and find/run the setup program. Follow the same 

steps as discussed in the FootScripts installation, namely, change the target file to 

the c:\foot_analysis_scheduler\ folder, hit the next button to start the installation 

and when the installation is complete copy all folders from the ISSI supplied 

foot_analysis_scheduler folder to the newly installed c:\foot_analysis_scheduler\ 

folder. 

Hardware Installation 

 Connect the computer and FootSTEPS system box with two USB cables: 1.

Connect the one with the blue connector and blue insert to the dedicated USB 3.0 

port on the computer and the other to a USB 2.0 port (black or white insert). 

 

 

 

 Attach SYNC HFC cable to the SYNC port on the FootSTEPS system box and the SYNC 2.

cable for the Force Plate Amplifier. 

 Connect the Force Plate Amplifier to the Computer with the USB 2.0 white cable. 3.
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Data Acquisition 

 System Startup 1.

The FootSTEPS acquisition software is designed to collect data, synchronously, from 

the ISSI S3F imaging system and the force plate.  The startup screen in shown below: 

 

After start, the FootSTEPS software will detect and initialize the three key hardware 

components of the system: 

• ISSI Pulse Generator (PSG synchronization controller) 

• ISSI Camera (S3F measurement system) 

• Force Plate (force measurement platform) 
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After successful initialization the system is ready to operate.  

 

The top toolbar allows control of the data acquisition process.  

  

Preview Button – Runs image capture synchronously with the LED light source to 

estimate image view and intensity values. In this mode the user can select a region of interest 

with the mouse and check the intensity stability and the intensity values, as an intial system 
check  The image below shows an intensity value of 50% (of the camera’s 12-bit full scale 

range) in the selected region of interest. 
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 Data Acquisition 2.

Start Button – Starts the data (force platform and S3F image data) acquisition process. 

Before hitting the Start button, the user should select the Work Folder – the folder where a 

subfolder with the patient data will be created.  

SPECIAL NOTE: Naming Convention of Work Folders and Data Files: Patient foot 

data folder and file names must not include any special characters; this includes spaces, extra 

dots, or any character other than alpha-numerics and underscores. For example: 
patientname.test.tif is not permitted nor patientname xxx xxx.tif. This is important in that the 

acquisition software allows special characters and does not warn you, however, the 

FootScripts script writer, discussed later in this manual, will create an erroneous script if it 

encounters special characters. 

After start the Patient Information dialog box allows user entry of patient 

information and which foot (left or right) will undergo data collection.  If the confidentiality 

process requires that patient names and IDs be stored separately, patient ID may be entered 

in both places. 
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After form completion and activation of the Start button, the acquisition process will 

begin.  The first stage will acquire 100 frames of no-load reference data, before the patient 

step. 

  

Following that the system will switch to waiting for STEP mode and will show what 

foot step is expected.  

  

After the patient steps on the FootSTEPS platform the acquisition process will 

continue until the patient is no longer touching the platform or until the maximum number 

of images is collected. 

     

Initially, all data will be acquired and stored in RAM (not on the hard drive!). 

16 
 



  Innovative Scientific Solutions, Inc. 
 

 Data Preview 3.

After acquisition, the data can be previewed and preprocessed to determine if the 

user wants to save it or needs to repeat the run.  Use the blue Play icon to start automatic 

image playback (~10 frames /sec) from the beginning, or use the slider to see specific frames. 

The two buttons to the left of the slider provide an estimate of normal pressure and shear for 

the current image.  

Normal load magnitude:  

 

Shear magnitude and vectors: 

 

If the data are satisfactory, use the Save button to save the captured data. Repeat the 

above process for additional runs with the patient.  
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Before saving you can confirm the data set you are working with. 

 

In case you forget to save the collected data and hit the Start button to collect a new 

run, you will be reminded before you lose unsaved data. 
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 Saving the Data 4.

 

In this example a subfolder will be created in the Work folder  (E:\#Data\Foot\) with 

the name “0_JohnSmith” where 0 is the patient ID and John Smith is the patient name. The 

following six files will be created: 

1. Patient data text-file (0_JohnSmith_Patient_data.txt) 

2. NoStep Averaged TIF-file for Left foot (0_JohnSmith_Left_no_load_avrg.tif) 

3. Step multipage TIF-file for Left foot (0_JohnSmith_Left_step_data.tif) 

4. NoStep Averaged TIF-file for Right foot (0_JohnSmith_Right_no_load_avrg.tif) 
5. Step multipage TIF-file for Right foot (0_JohnSmith_Right_step_data.tif) 

6. Foot plate data text-file (0_JohnSmith_Left_forceplate_data.txt) 

7. Foot plate data text-file (0_JohnSmith_Right_forceplate_data.txt) 

The Patient data file contains information about all data files: 

[Patient_Data] 
ID=0 

Name=JohnSmith 

Sex=Male 

Age=38 
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[Data] 

Left_foot_images=148 
Left_foot_file=E:\\#DATA\\Foot\\0_JohnSmith\\0_JohnSmith_Left_step_data.tif 

Left_foot_average_images=100 

Left_foot_average_file=E:\\#DATA\\Foot\\0_JohnSmith\\0_JohnSmith_Left_no_load_avrg.tif 

ForcePlate_data_file=E:\\#DATA\\Foot\\0_JohnSmith\\0_JohnSmith_Right_forceplate_data.txt 
Right_foot_images=125 

Right_foot_file=E:\\#DATA\\Foot\\0_JohnSmith\\0_JohnSmith_Right_step_data.tif 

Right_foot_average_images=100 

Right_foot_average_file=E:\\#DATA\\Foot\\0_JohnSmith\\0_JohnSmith_Right_no_load_avrg.tif 

 System Settings 5.

System settings are available to modify several data acquisition parameters, such as 

camera gain, number of images collected, and so on.   

 

However, inappropriate settings can result in a non-operational system, noisy data, 

and a number of other undesirable conditions. If you are uncertain about changing the 

settings, press the Default Settings button and then apply them with Apply button.  Please 

contact Mr. Nikolay Rogoschenkov at ISSI (nrogoshchenkov@innssi.com, 937-9630-3012, 

x114) if you believe that a settings change is required but you are not certain how to proceed. 

Data Processing 

 Overview 1.

Four software programs are utilized in the processing of foot step data taken with the 

ISSI FootSTEPS system. This includes: the FootScripts program, the Foot_Analysis_Scheduler 

program, the FreeFEM++ program, and the FootPlots program.  
20 
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Step data force reconstruction analysis occurs in a batch mode process controlled by 

analysis scripts. The main program for writing these analysis scripts is the FootScripts 

program. This program creates an analysis script for each foot step acquired with the 

FootSTEPS system. Specific instructions for running this program are located in the next 
section. Briefly, the user selects the foot step data for analysis, the program finds the starting 

frame of the foot step and the ending frame of the foot step on the S3F window so that only 

frames that have foot contact data are processed, and finally an analysis script is created. The 

steps in the analysis script consist of 1) creating displacement components (measuring the x, 

y, z displacement of the S3F film caused by the foot contact through cross-correlation and 

ratiometric analysis), 2) reconstructing the forces that caused the measured displacements by 

way of a FEM script that calls the freeFEM++ program, and 3) converting the text output force 

data from the freeFEM program to a binary format for fast loading into the FootPlots program 

for post analysis. 

The script created by the FootScripts program can be launched by the user or can be 

launched is a batch mode using the Foot_Analysis_Scheduler program. Detailed instructions 
for using the scheduler are given below, but briefly, the analysis scripts to be processed are 

loaded into the scheduler and based upon the number of computer cores available for 

analysis, a series of batch scripts (one for each core selected) is created. For example if four or 

more cores are available for processing on the analysis computer and the user selects four 

instances, then four scripts (script0, script1, script2, script3) will be created in a folder entitled 

BATCH_Foot_Analysis. The user should navigate to this folder and launch each of the scripts, 

separately. A Command Prompt window will be displayed for each script launched indicating 

the current processing step. When the analysis is complete, the Command Prompt windows 

will close and the data is now ready for post analysis by the FootPlots program. 

The force reconstruction data is available in two different formats. An asci text format 

*.dat and a binary format *.bin. The binary format is used for fast loading by the FootPlots 
program. Detailed instructions for using the FootPlots program are given below, but briefly, 

the force reconstruction data is loaded into the FootPlots program for post analysis. The 

individual data frames are loaded and can be easily displayed by this program. Spatial and 

temporal plots of the force data are accessible in this program. 

The *.dat force reconstruction file should be accessible in MatLab or other graphic 

packages such as Tecplot. The text format of the force resconstruction *.dat file is listed 

below. The columns include: X, Y, fx, fy, fx, dx, dy, and dz where X,Y are the spatial locations 

of the forces (in mm), fx is the reconstructed ML shear, fy the reconstructed AP shear, fz the 
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reconstructed pressure, dx the displacement-derived ML shear, dy the displacement-derived 

AP shear, and dz the displacement-derived pressure.  All force variables are in pascals. 

 

 FootScripts Program 2.

The FootScripts program creates the batch script for analyzing step data from the ISSI 

FootSTEPS system. The program looks for a minimum of four files in each step folder. The files 

include the step no-load data, the step load data, the step force plate data, and the patient 
information. The step data can be either a left or right foot step, but at least one of them must 

be present for processing. The program creates the analysis script via the following steps: 1) 

calculate displacements of S3F film by correlation and image ratioing, 2) reconstruct the 
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forces needed to match the measured S3F film displacements using a freeFEM++ script,  and 

3) convert force data from text to binary format for fast loading by the FootPlots program. 

The program can handle either dynamic (step) or static (calibration) data files.  

To start the process, the user should locate the FootScripts 

program and launch it.  The Foot Analysis Script Writer will then 

appear. The user should select the Locate Data Directory button at 

this point to identify which data set is going to be analyzed.    

  

After selection of this dialog button, the program will display a Select Data File 

Directory dialog, and the user should navigate to the location of the data to be processed. 

Once this is accomplished, select the Done button and proceed to select the scripts to be 

written.  
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Note that the user-selected data file name is then displayed in the adjacent text box. 

  

Next the user should decide whether the script will be split into four 

scripts or be kept as a single large one.  As a rule of thumb, if a single step is 

being processed and the analysis computer has four or more cores, it is advisable to split the 

script to take advantage of the multiple cores. However, if multiple steps are to be analyzed at 

the same time, it is advisable not to split the script and just make one large script for each 

step and run as many steps as there are computer cores in the batch mode.  

The user should now select which analysis steps will occur, including Calculate 

Displacement Components, FreeFEM Analysis, and Convert FEM to Binary. Because all steps 

are necessary for post-analysis of the step data with the FootPlots program, it is advised that 

the default settings be used (all processes selected).   
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Once the user has selected the Data Directory location and 

the analysis to be accomplished, the Create Analysis Scripts button   

becomes active and should be selected to create the analysis script. 

The analysis script will be created in the Data Directory selected by the user. A folder named 
Components_Left_xxxxxx (and/or Components_Right_xxxxxx) will be created and inside this 

folder will be a FEM_xxxxxx folder which will include the FEM force reconstruction text and 

binary file versions. Note the xxxxxx is a unique number generated at the time of writing the 

script by the FootScripts program. The FEM binary files are the ones used by the FootPlots 

software described in the Data Visualization and Analysis section. 

During the process of creating the analysis script, the program determines when the 

step actually occurred relative to the triggering of the force plate. This procedure is necessary 

since the force plate and the foot sensor acquisitions can be triggered prior to the foot 

making contact with the S3F image sensor.  This selection process is affected 

by the threshold setting shown in the threshold numeric. The default value of 

-2500 should be good for most step data. For dynamic calibration data, this 

value should be lowered to ~ -500. Note, that the 

threshold is a negative value. It will take several 

seconds to find the beginning and ending foot 

contact frames. The image frame for the beginning 
of the step and for the end of the step are displayed in the section below for the left and/or 

right foot.  

The program will display a busy cursor while it is in the process of finding the 
beginning and final step frames and as it writes the analysis script to the step data file. Once 

this process is complete, as indicated by the return of the normal cursor, the user can either 

navigate to a new step and write another analysis script or exit the program. 

To start the batch analysis process, the user should 

locate the FootAnalysisScript_Left_xxxxxx (and/or 

FootAnalysisScript_Right_xxxxxx) command script and launch it by double clicking. Note that 

if the scripts were split, then four FootAnalysisScriptA, FootAnalysisScriptB, 

FootAnalysisScriptC, and FootAnalysisScriptD scripts will be created. To start this analysis, 

launch each of the four files separately. When the analysis is complete, the display window 

showing the progress of the analysis will disappear. The analysis should now be complete and 
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the data ready for any post-processing. This can be accomplished with the FootPlots program 

or by a user-developed Matlab program. 

 Foot_Analysis_Scheduler Program 3.

The Foot_Analysis_Scheduler software allows the user to select and schedule the 

analysis scripts for batch mode processing of the foot step data. This program allows the user 

to select the scripts to be processed (generated by the FootScripts program), determine the 

number of instances (cores) to be used in the analysis and creates a series of batch analysis 

scripts which the user will launch for batch step analysis. The reason for this program is that 

the analysis scripts created by the FootScripts program requires the user to launch them 

individually and thus the user must continuously monitor the analysis progress over an 
extended period of time. However, all scripts cannot be processed at the same time. This 

program combines the individual scripts into a batch file based on the number of cores 

available in the analysis computer. For example, a 3 core machine can run two instances of 

the batch analysis, while a 5 core can run 4 instances, and so forth. As an example, to process 

twenty steps in a 5 core machine, the twenty individual scripts would be loaded into the 

Foot_Analysis_Scheduler program with 4 instances being selected, and a 

BATCH_Foot_Analysis folder containing 4 scripts (one for each instance) will be created. The 

user would then launch each of the 4 scripts in the analysis folder which would start the 

processing of all twenty steps. 

To start the Foot_Analysis_Scheduler, find the program folder and launch the 

program. The dialog shown below will appear. 
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The next step is to select the load scripts button and the load file 

dialog will appear.  
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Navigate to the foot step analysis scripts that were created by the FootScripts program 

and select the scripts you wish to process. This process should be repeated for each script you 
wish to analysis and when complete select the OK button. The script names will then be 

loaded into the Foot_Analysis_Scheduler dialog along with the number of files loaded by the 

user.  

28 
 



  Innovative Scientific Solutions, Inc. 
 

 

The user should next select the Save Locale button and navigate 

to the folder in which the user wishes to save the analysis scripts and 

select the Done button.  

The user should next select the number of instances to be  created 

in the BATCH_Foot_Analysis folder. To actually create the batch analysis 

scripts, select the Create Batch Analysis Scipts button. The batch analysis 

scripts are written to the BATCH_Foot_Analysis folder. Exit the 
Foot_Anlaysis_Scheduler and then locate the 

BATCH_Foot_Analysis folder and then launch each of the script 

files (script0….scriptX, where X is the number of instances -1) and the analysis will start.  

 

Each script, when launched, will open a Command Prompt window which indicates 

that the analysis is currently underway. When finished, all Command Prompt windows will 

close. 
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Data Visualization and Analysis 

 Starting FootPlots 1.

Once the foot data have undergone the reconstruction process, they can be visualized 

with the FootPlots program. To start the program navigate to the FootPlots executable, and 

launch the program. The program will display the dialog shown below.  

 

 Loading FEM Binary Files 2.

The first step is to load the FEM binary result files 

using the Load File button.  

The program will immediately display the Select Vector Files dialog that asks the user 

to find the FEM binary files to be loaded. The user should navigate to the FEM binary files, 
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select the files (frames) to be loaded and hit the Add button on the dialog to select the files 

and then the OK button to load the files into the FootPlots program.  The location of the FEM 

binary files will be the data directory selected when running the FootScripts program. A 
folder named Components_Left_xxxxxx (and/or Components_Right_xxxxxx) was created 

and inside this folder is a FEM_xxxxxx folder which includes the FEM force reconstruction text 

and binary file versions. The FEM binary files are the ones used by the FootPlots software. 

 

The FootPlots program will display the pressure, anterior/posterior shear, and 

medial/lateral shear results for the selected frame (at the 

cursor location), display the total number of files loaded,  

display a list box containing the names of the files loaded, and activate all program functions.  
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 Displaying Data Files 3.

The foot-step results can be displayed in several ways; a complete scan 

through all of the data can be made by selecting the Scan > button.  A dialog 

will appear asking the user to select whether the vectors will be plotted and whether the scan 

should start from the beginning frame. The user should then select the Start Scan button, 
and the entire loaded result files will be displayed. If the option to turn off the vector plot is 

chosen, the speed of the display will be increased. 
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The scan can be halted at any point by selecting the Stop button.   

 

Individual frames can be plotted by selecting the <, Plot, or > 

buttons.  The < button will display the previous frame; the Plot 

button will display the currently selected frame; and the > button will display the next frame. 

Note that an arbitrary frame can be plotted by simply highlighting the frame by placing the 

cursor on the name, left-clicking the mouse, and then hitting the Plot button.  

 

The initial display of the FEM data is autoscaled, and the max’s and min’s of the 

various parameters are shown in the Scale numeric boxes. To rescale the plots, select the 

parameter to be scaled [pressure, anterior(+)/posterior(-) shear, or 

medial(+)/lateral(-) shear] turn scale from Off to On, and manually enter the scale 
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max and min values. Then hit the Plot button to update the displayed plots.  

 

 Making Composite Images 4.

Composite frames can be constructed by selecting the Composites 

button. The composite images/frames are added at the end of the data set 

and are called Composite – Sum and Composite – Peak. Composite-Sum is the average 

value for all of the data loaded, and Composite – Peak is the peak value for all of the data 

loaded at each x-y location. The composite data is used to determine the foot zones (to be 

discussed later). 

 Displaying Individual Data Values 5.

The value of the pressure or shear components for the displayed frame can be 

determined by placing the cursor at the desired point of interest and reading the numerical 

displays.  The pressure, anterior/posterior shear, medial/lateral shear, and the AP-X – ML-Y 

locations of the current cursor position will be displayed in the appropriate numeric box. 

 

 Using Vector Plot Controls 6.

The vector plot controls allow the user to control the display of the vector information. 
Because the vector density is high, it is important that not all vectors be displayed since this 

will overwhelm the image displays. In some instances the user may wish to forgo the vector 

plots all together in order to increase the speed of an image scan or select the zones for 

analysis. Vector plots can be turned on and off with the Plot Vectors toggle switch. The 

displayed vector size (Vector Size), number of vectors to skip (Skip Vector), and vector color 

(Vector Color) can be user selected. The default values for the vector plots are shown below. 
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 Displaying Line Plots 7.

The pressure, anterior/posterior shear and medial/lateral shear can be 

displayed in line plots for the currently displayed data frame by selecting the 

type of line plot to display from the Line Plots pulldown. The options are 1) 

Row, 2) Column, and 3) Line (freehand line). Selecting a Row line plot will 

result in the display shown below.  The user should click on the desired row 

to be displayed and the Row Line Plot graph will appear. To save the plot information, the 

user should select the Save Plots button, and an ascii excel file will be created. 
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Selection of the Column line plots causes the data along the user 

selected column to be graphed. As with the Row line graph, the user has 

the option to save the graphical data by electing the Save Plots button. 

 

 

 

 

 
 

The third line plot option is a freehand line. An arbitrary line can be 

drawn on any display by moving the cursor to the start position, clicking and 

holding the left mouse button, moving the cursor to the line endpoint, and 

releasing the left-mouse button. A line will be displayed and the associated 
data graphed. As with the other line plots, the user can save the data by 

selecting the Save Plots button. 
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 Displaying Time Plots 8.

Data can also be displayed as a function of time for each of the loaded 

frames by selecting the Time Plots pulldown. The available time plots are 1) 

Point, 2) ROI (Rectangular Region of Interest), and 3) IROI (Irregular Region 

of Interest). The Point time plot is illustrated below. Here the time history of the pressure, 

anterior/posterior shear, and medial/lateral shear are displayed for a user selected point as a 

function of time (frames loaded into FootPlots). As with the line plots, the graphical data can 

be saved in an ascii excel file if desired. 
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The ROI time plot is illustrated below. Here the user selected ROI is 

shown both for the peak values (black) and the average values (red). Once 

the ROI pulldown is activated, an ROI can be selected by moving the cursor to 

the upper left hand point of interest, clicking and holding the left mouse button, expanding 

the rectangle to cover the entire region of interest, and then releasing the left mouse button. 

The graphics data corresponds to the mean and peak values for that ROI.  Note that the user 

can save the data as an ascii excel file.  The saved data includes an ascii excel file that provides 

the coordinates of the ROI.   
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The final time plot is an IROI which is user selected by activating the 

IROI pulldown time plot. Then move the graphic cursor to the pressure 

display; this cursor is indicated by the cross-hair/arrow-head combination. 
Move to the first point of interest and right or left click the mouse (do not hold down the 

button); move to the next point and right or left click the mouse; and proceed until an 

enclosure back to the original point has been made. The IROI should be displayed along with 

the graphical results. As with the ROI, the IROI shows both the mean and peak values. Data 

can be saved as an ascii excel file.  As with the ROI, The saved data includes an ascii excel file 

that provides the coordinates of the IROI. To erase the IROI from the graphics displays, the 

user should hit the plot button. 

 

If the user is right clicking the mouse and the program is not drawing the IROI, then it 

is likely that the graphics cursor is not located in the pressure display. 
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The next series of time plots is the integrated force time plots that are used to 

compare the integrated forces of the S3F image sensor to those of the force 

plate. There are two options for force plots F-All and F-ROI. F-All calculates the 

integrated forces over all of the foot sensor’s field of view. The user selects 

this from the Time Plots pull down and the program then asks what 

thresholds are to be applied.  

The thresholds affect both the pressure and 

shear plots. Once the thresholds are entered, then a 

comparison plot is displayed to the user. The solid 

yellow line in this figure corresponds to the force plate 
results while the red squares corresponds to the 

integrated forces of the S3F image sensor (in units of 

Newtons).  
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Force Plate Results (yellow line) with S3F Image Sensor Integrated Forces (red-

squares) 

The F-ROI function works much the same as the F-ALL except the user must select a 

region of interest over which the force integration occurs. The user must still enter a 

threshold for the pressure and shear data.  The comparison plot is then displayed with the 

force plate and image sensor data. To save this data the user must select the SAVE button on 

the comparison plot which allows the data to be stored in an asci text format which can be 

read with Excel or any other text readers. 

 Establishing Zones and Zonal Analysis 9.

Zones refer to the 10 zones/areas established by Cavanagh, et al. (1987) for studying 

foot dynamics. Since zones are established relative to the pressure display, it is important that 

all parts of the foot step be visible in the pressure image. To accomplish this, before starting 

the zone creation procedure, the user should do the following: 
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1) Select the Composites button (see Section 4), and create the composite images (if 
not created already).  Next, select the Composite-Sum and hit the Plot button to 
update the displays along with the max’s and min’s.  

2) Turn off the vector plots by turning the Plot Vectors toggle to Off (see Section 6). 
3) Turn the Scale Pressure Plot toggle to On; and while leaving the max value as is, 

enter a value of -100000 for the pressure min. Then hit the Plot button to update the 
display with the new pressure scale.  

4) Re-adjust the max and min scale if all parts of the pressure image are not clearly 
visible.  
 

To start the zone analysis, select the Zones button.  The Create Zones 

dialog will appear, giving the user the option to create zones or load previously 

created zones.  

 

 
 

To start the graphic creation of zones, the user should 

select the Create New Zones button, and the Draw Foot 
Boundary button will become active.   Select the Draw Foot 

Boundary button and place the graphic cursor (the combined 

cross-hair/arrow-head) at the beginning of the lateral heel of the pressure image as shown in 

the sequence of images below. Right-click the mouse (once and release), and proceed to the 

42 
 



  Innovative Scientific Solutions, Inc. 
 

next point that is located at the region just below the lateral metatarsals.  Right-click the 

mouse for the second point, and a line will be drawn between the first and second points.  

Next move the cursor to the region between the 2nd and 3rd toes and right-click the mouse. An 

additional line segment will be displayed. Move the cursor to the point above the medial 1st 
metatarsal, and right-click the mouse.  Another line segment will be added as a result. Move 

the cursor to a point above the medial heel region, and right-click the mouse (another line 

segment will be added). Finally move the cursor to the starting point, and right-click which 

should result in the completion of a coffin-shaped enclosure around the foot minus the toes.  

Once the outer region is complete, the program will subdivide the foot into six zones. 

 

 
First Point in Draw Foot Boundaries – Lateral Heel. 
 

 
Second Point in Draw Foot Boundary – Lateral Metatarsals. 
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Third Point in Draw Foot Boundary – Between 2nd  - 3rd Toes. 

 

 
Fourth Point in Draw Foot Boundary – Medial 1st Metatarsal. 
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Fifth Point in Draw Foot Boundary – Medial Heel. 

 

 
Sixth Point in Draw Foot Boundary – Lateral Heel. 
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Boundaries of Draw Foot after Draw Foot Boundaries Procedure. 
 

 Next, the Draw Toes Boundary will become active.  To 

proceed, select this button and draw the toes boundaries. This is a 

multi-step process that is similar to the draw foot body boundary except that it concerns the 

toes. A total of eight line segments will be drawn between the following points: 

1) the first starting from below the lateral metatarsal and proceeding,  

2) to the outer small toe  

3) to the region between the 2nd and 3rd toes 

4) to the region between the hallux and the 2nd toe 

5) to the medial region above the hallux 

6) to the outer medial region of the 1st metatarsal 

7) to the region between the hallux and the 2nd toe 
8) to the region between the 2nd and 3rd toes, and finally 

9) to the starting region below the lateral small toe 

As with the foot boundary, each segment is determining by moving the cursor to the 
correct region and right-clicking the mouse. When determination of the toe boundaries is 

complete, the program will display all ten zones.  
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Starting Point of Draw Toe Boundaries – Below Lateral Metatarsals. 

 

 
Second Point of Draw Toe Boundaries – Outer Lateral Small Toe. 
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Third Point of Draw Toe Boundaries – Between 2nd and 3rd Toes. 

 

 
Fourth Point of Draw Toe Boundaries – Between Hallux and 2nd Toe. 
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Fifth Point of Draw Toe Boundaries – Above Medial Hallux. 

 

 
Sixth Point of Draw Toe Boundaries – Outer Medial Region of 1st Metatarsal. 
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Seventh Point of Draw Toe Boundaries – Between Hallux and 2nd Toe. 
 

 
Eighth Point of Draw Toe Boundaries – Between 2nd and 3rd Toes. 
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Ninth and Final Point of Draw Toe Boundaries – Starting Point at Lateral Small Toe. 

 

 
Zones Identified After Foot and Toes Boundary Procedure. 

 

The Save New Zones button will become active, and the 

user can save the regions.   Once the zones have been saved, the 

Run Time Series button will become active, and a time plot for 

each zone will be generated.  This is illustrated below where all zones are 

initially plotted on a single graph. Note that the time plot information is 
automatically saved as an ascii excel file with the save zone name.  For example, if the save 

zone name was Zones, the running of a time series will automatically create two files named 

Zones_graph.csv and Zones_graph_coords.csv that contain the time data for each zone and 
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the boundary coordinates, respectively. The data in these files are ascii comma separate value 

(*.csv) files that can be read with any text reader or with the Excel program.  

Note that the individual zone plots can be turned on or off by selecting the 

appropriate toggle box that is located at the bottom of the graph and hitting the Plot button 

to refresh the graphs. When finished inspecting the graphs, the user 

should hit the Exit button to clear the graph and the Clear Zones 

button and the Exit button to exit the zone procedure.  
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Any previously saved zone can be loaded by selecting the Load 

Zones button and navigating to the directory containing the zones.  The 

zone info will be loaded and shown on the FootPlots display.  A Time 

Series can then be run by selecting the Run Time Series button. 

 Saving Displays and Plots 10.

The pressure and shear displays of the FootPlots program can be saved either as Tiff 
files that can be combined to produce movies, or as text files for export to 

programs for further analysis. This is accomplished by selecting either the 

Save All Plots button  or the Save Current Plots button. In the Save All 

Plots case, all of the loaded images will be saved by FootPlots to a user-

selected directory. Activating this button causes the Save Plots dialog to be displayed to the 

user. The user should decide which plots to save -- either the composite images (pressure, 

anterior/posterior shear, and medial/lateral shear) or individual text plots of the pressure, 

anterior/posterior shear, and medial/lateral shear. The composite images will be Tiff files that 

mirror those displayed by the FootPlots program, including vectors if vectoring plotting is 
selected, while the text images will be three individual files for each frame of data in an ascii 

format.  Both outputs can be read with the ImageJ program and used for further analysis.  The 

user should activate the Save File Local to inform the program where to save the images and 

the Save button to save them. The program will then display each frame, beginning with the 

first, and save a copy of it to the desired location.  
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If the Save Current Plots is selected, then, the same Save Plots dialog is displayed to 

the user; however, only the currently displayed frame will be saved. 

Note that both Save Plot procedures utilize the current Plot Vector and Scale Plot 

vector plot settings to display and save the data. If the user wishes to change these settings 

so that all the images are on a common scale, this must be done before hitting the Save 

button. 

To create an AVI movie film from the Composite Images saved by the FootPlots Save 
All Plots function, the following procedure should be followed: 

1) Start the ImageJ program. 
2) Load the saved composite tiff images - File>Import>Image Sequence. 
3) Save the image sequence to an AVI movie file - File>Save As>AVI. 
4) Exit ImageJ 

 Loading Masks and Clearing Masks 11.

The Load Mask function allows the user to load a text image created in 

ImageJ as a mask for masking of the foot image. To load the mask, hit the Load 

Mask button and select the text mask image to load.  The user should hit the 

Plot button to update the current displays, and the masked foot display will 

be shown. To clear the mask, select the Clear Mask button, and the mask will be erased.   The 

ImageJ procedure to create a text mask image is as follows: 

1) In the FootPlots program create the Composite images. Select either the Composite-
Sum or the Composite-Peak image and hit the Plot button to ensure that this is the 
currently selected image.  Select the Save Current Plots function and have the 
program save the individual text images.  Note that all three pressure and shear 
images will be saved; however, for masking only the pressure image will be used. 

2) Start the ImageJ program and using File>Import>Text Image, locate the pressure 
image just saved by the FootPlots program and load it.  An example is shown in the 
image sequence below.  Now in ImageJ select Image>Adjust>Threshold and adjust 
the threshold so that the foot is the primary image.  Hit the Apply button in the 
threshold dialog and convert the image to one in which all pixels below the thresold 
are zero and all pixels above the threshold are 255.  Next, using the Color Picker tool 
and the Paintbrush tool, fill in any missing areas for the foot or cover up any noise 
areas outside the foot.  Finally, using the File>Save As>Text Image, save the mask 
image. 
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Pressure Composite-Sum Image Saved as Text Image and Displayed in ImageJ. 

 

 

Pressure Image after Applying Threshold. 
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Pressure Image after Using Color Picker and PaintBrust to Eliminate Noise and Fill in 
Missing Regions. 
 

3) Once created the mask can be loaded into the FootPlots program and used to mask 
off areas where no data is present. An example is shown below. 
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Composite-Sum Image for a Foot Step. 
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Composite-Sum Image for a Foot Step after Loading Mask Image. 
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Export Disclaimer 
Any and all underlying information and technology contained in this document may 

be subject to U.S. export controls, including the Export Administration Act (50 U.S.C. Appx. §§ 

2401 et seq.) and the Export Administration Regulations ("EAR", 50 C.F.R. Parts 730-774), and 

may be subject to export or import regulations in other countries. You are responsible for 

complying with all trade regulations and laws both foreign and domestic. Except as 

authorized by law or distributor agreement with ISSI, you agree and warrant not to export or 

re-export the information to any country, or to any person, entity, or end-user subject to U.S. 

export controls, including without limitation persons or entities listed on the U.S. Department 

of Commerce Bureau of Export Administration's Denied Parties List and the U.S. Department 
of Treasury's Specially Designated Nationals. You further represent and warrant that no U.S. 

federal agency has suspended, revoked, or denied your export privileges. 

Software License Agreement and Limited Warranty 

This License Agreement is between you (“Customer”) and ISSI, the author of the ISSI 
FootSTEPS software and governs your use of the program, example results, and 
documentation (all of which are referred to herein as the "Software").  THIS IS A LEGAL 
AGREEMENT BETWEEN YOU (EITHER AN INDIVIDUAL OR AN ENTITY), THE END USER, AND ISSI. 
IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, PROMPTLY RETURN THE DISKS 
AND ACCOMPANYING ITEMS TO ISSI, AND/OR DO NOT DOWNLOAD THE SOFTWARE FROM 
OUR WEB SITE AND/OR DO NOT INSTALL THE SOFTWARE. 

 Grant of License 1.

ISSI grants to you a non-exclusive, non-transferable license, without right to sublicense, 
distribute or modify, for you and your employees to use the enclosed software and related 
documentation (collectively the "Product" or the “Software”) as delivered by ISSI only at one 
location for the testing and evaluation. If the terms of this license agreement are violated, ISSI 
immediately terminates said license and the customer is subject to the liability of any harm 
done to ISSI. 

59 
 



  Innovative Scientific Solutions, Inc. 
 

 Title 2.

The product, with the exception of the force plate, force amplifier, and any force plate 
software components, is copyrighted by ISSI. ISSI retains all rights, title, and ownership of the 
Product and all subsequent full or partial copies and derivatives of the Product, made by you 
or ISSI, including translations, compilations, partial copies, modifications, updates and know-
how in connection there with, regardless of the form or media in or on which the same may 
exist. This license is not a sale of the Product or any copy or derivative. You shall have no right 
to reproduce any full or partial copies of the Product. You agree not to take any steps, such as 
reverse assembly or reverse compilation, to derive a source code equivalent of any software 
contained in the product. You also agree to destroy licensed data in all forms upon 
termination of said license or receipt of released program code. 

 Confidentiality 3.

You agree that the product, and other information, technical data, or know-how (including 
documentation) related to the Product (including the existence of the product and the 
results of use or testing), shall be considered Confidential Information of ISSI. You agree to 
protect the confidentiality of all Confidential Information of ISSI, and not to disclose the 
Confidential Information to any other party without the written permission of ISSI. 
Unauthorized use or disclosure of the Product may cause irreparable harm to ISSI. You agree 
promptly to report any unauthorized use or disclosure to ISSI. 

 Warranty of Functionality 4.

ISSI hereby represents and warrants that ISSI is the owner of the Product or otherwise has the 
right to grant to you and your employees the rights set forth in this Agreement. THE 
PRODUCT IS PROVIDED "AS IS". THERE ARE NO WARRANTIES UNDER THIS AGREEMENT, AND 
ISSI DISCLAIMS ANY IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR 
PARTICULAR PURPOSE. In the event of any breach or alleged breach of this warranty, you 
shall promptly notify ISSI and return the Product to ISSI at your expense. Your sole remedy 
shall be that ISSI shall correct the Product so that it operates according to the warranty. This 
warranty shall not apply to the Product if modified by anyone or if used improperly or with, 
on, in an operating environment not approved by ISSI. 

 Limitation of Liability 5.

IN NO EVENT SHALL ISSI BE LIABLE FOR ANY LOSS OF PROFITS, LOSS OF USE, SPECIAL, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES PURSUANT TO THIS AGREEMENT. ISSI shall not 
be responsible for, and shall not pay, any amount of incidental, consequential or other 
indirect damages, whether based on lost revenue or otherwise, regardless of whether ISSI 
was advised of the possibility of such losses in advance. In no event shall ISSI's liability 
hereunder exceed the amount of license fees paid by you, regardless of whether your claim is 
based on contract, tort, strict liability, product liability or otherwise. 
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 Product Maintenance 6.

During the Warranty Period, ISSI shall provide to you any new, corrected or enhanced version 
of the Product as created by ISSI. Such enhancement shall include all modifications to the 
Product which increase the speed, efficiency or ease of use of the Product, or add additional 
capabilities or functionality to the Product, but shall not include any substantially new or 
rewritten version of the Product. These updates will require Internet Access to our web site to 
automatically validate your License Key and provide update support. 
 
After expiration of the Warranty Period, you may continue to receive maintenance support. 
The charge for such optional maintenance support shall be ISSI's regular list price for 
maintenance and support for the Product as published from time to time by ISSI. You will 
need to notify ISSI in writing if you desire to receive optional maintenance. If you fail to take 
optional maintenance and later elect to receive it, ISSI reserves the right to charge you their 
standard maintenance fees for the period of the lapse in maintenance. ISSI may elect to 
discontinue maintenance at any time upon notice to you, and refund of any then unearned 
maintenance fees. 

 Proprietary Rights Exclusion 7.

ISSI makes no representation or warranty that the Product, or products developed using the 
Product, do not infringe any proprietary rights of any third parties. You shall assume sole 
responsibility for any such infringement. 

 Indemnification 8.

You hereby agree to indemnify, defend and hold ISSI harmless from and against any and all 
claims, actions, suits, liabilities, judgments, losses, damages, attorneys' fees and other 
expenses of every nature and character by reason of this Agreement or use by you of 
products utilizing the Product. 

 Export Restrictions 9.

You shall not export, directly or indirectly, any Product or products developed using the 
Product to any country for which the laws of the United States or the regulations of any U.S. 
agency requires an export license or other governmental approval, without first obtaining 
such license or approval. You shall strictly comply with all such restrictions. You agree to 
indemnify and hold ISSI harmless against all losses, damages, penalties, or causes of action 
resulting from a violation of this Section. 

 Anti-Piracy and License Activation 10.

You must not engage in the distribution of pirated software or hardware. Use of the Product 
may be limited to the first 14 days after the end user first use the software, unless the end 
user activates the Product, as described in and by the Product. Certain ISSI products may use 
technological measures for copy protection. In that event, you will not be able to use the 
Product if you do not fully comply with the Product Activation Procedures. Product Activation 
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will take place during initial launch of the product, installation on a different system, or 
replacement of the installed operating system or certain hardware changes. 

 Governing Law 11.

The validity, performance, construction and interpretation of this Agreement shall be 
governed by laws of the state of Ohio, United States of America, excluding its conflicts of laws 
rules, as applied to agreements entered into in Ohio between Ohio residents. 

 High risk activities 12.

The software and/or hardware supplied by ISSI is not fault-tolerant and is not designed, 
manufactured or intended for use or resale as on-line control or equipment in hazardous 
environments requiring fail-safe performance in which the failure of software and/or 
hardware could lead directly to death, personal injury, or severe physical or environmental 
damage ("high risk activity"). ISSI and its suppliers specifically disclaim any express or implied 
warranties of fitness for high risk activities. 
 
Should you have any questions concerning this Agreement, please write to: 
ISSI, 7610 McEwen Road, Dayton, Ohio 45459. 
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